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4	 GETTING	THE	RENESAS	SYNERGY™	PLATFORM	
						TOOLCHAIN	UP	AND	RUNNING

In this chapter we will download and install the tools necessary to work on software projects for the Synergy Platform. You have 

the choice between two different toolchains: The e2 studio ISDE with the Synergy Software Package (SSP) or the IAR Embedded 

Workbench® for Renesas Synergy™ (IAR EW for Synergy) together with the Synergy Standalone Configurator (SSC) and the SSP.

The following paragraphs will outline all the steps necessary and you will find that the installation of both toolchains is free of any 

hassle as the installers will take care of everything needed, once you made your selections on what and where to install. After the 

installation is done we will perform a short sanity check to ensure that the installation is working.

First step of the installation process is to go to the Synergy Solutions Gallery on the web at https://www.renesas.com/eu/en/

products/synergy/gallery.html, which is the convenient single point of access to everything needed for the development of 

a Synergy application: Development environments, compilers, tools, documentation and support. The complete ecosystem is there 

at your fingertips. And not only from Renesas, but also from Express Logic, IAR Systems® and all partner companies.

To download any of the tools it is necessary to register as a user. Registration is straightforward with only a few questions to be 

answered before access to the site is granted. To register, simply click on Sign in at the very top of the page. This will get you 

to the My Renesas login page, where you can also register by clicking on the orange Register now! button at the bottom of 

the page. Follow the steps and you are all set. If your company is already registered, you might want to ask your Company 

Super User to add you to the company’s user database as well.

Once registered, a simple log-in will be enough to browse the site and to download most software packages immediately. And just in 

case, you have a question the web site doesn’t answer, there are plenty of options to contact Renesas for help.

One possibility is to search the Knowledge Base for answers or to post more complex questions to the Renesas Rulz forum, discussing it 

with other Synergy developers. On the support page, you can also access documentation, the Synergy Academy or the training videos on 

the official Synergy Platform channel on YouTube.

For getting going with the Renesas Synergy Platform, only two software packages are necessary: The Eclipse-based e2 studio Integrated 

Solutions Development Environment (ISDE) and the Renesas Synergy Software Package (SSP). There are other packages available, like 

TraceX® from Express Logic or the IAR Embedded Workbench® for Renesas Synergy™, but they are not essential right at the beginning. 

There are no upfront costs associated with all the tools on the Solutions Gallery.

4.1 Introduction to the Synergy Solutions Gallery

What	you	will	learn	in	this	chapter:

	¡ Where to get and how to install the toolchain(s) for the Synergy Platform.

	¡ Steps to be performed during the first startup of the Integrated Solutions Development Environment (ISDE).
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4.2 Downloading and Installing e2 studio and the Synergy Software Package 

e2 studio contains all the tools necessary to create, compile and debug projects for the Synergy Platform. It is called Integrated Solutions 

Development Environment (ISDE), as additional solution-oriented components and plug-ins have been added, making it more powerful. 

This is especially true for the configurators, which allow an easy graphical access to the different hardware features like the clock 

module or the pin configuration without the need for deep study of the user’s guide. These configurators will create all the necessary 

settings and the initialization code automatically, and they include an error-checking feature to detect problematic settings already at 

design time, saving tons of hours otherwise spent for writing and / or debugging code not adding value to the application itself. At least, 

I would have been more than happy if such tool had been available when I first started writing software for embedded processors. 

It’s so much easier with the Synergy Platform!

The next paragraphs will walk you through the different steps of downloading and installing e2 studio and the SSP on your Windows® 

workstation. You have two choices: You can either use the Platform Installer, which installs both e2 studio and SSP in a single step or 

use the Standalone Installer for each individual package. It is up to you, and it does not really matter how you decide. The results will 

be the same.

4.2.1 Download of e2 studio and the SSP

The first step is to download the installation packages. On the Synergy Solutions Gallery, make sure that you have 

logged into My Renesas and scroll down to Software Tools and click on the e2 studio entry. The page for the ISDE will 

show. Scroll down to the Download section of the page and click either on Download Platform Installer or on Download 

Standalone Installer at the right-hand side of the current public release. When the license agreement for one of the 

installers pops up, read and accept the agreement by clicking on the I Accept button and the download of the zipped 

installer will start. While either the Platform Installer or the installer for e2 studio is downloading, take some time to 

review the documentation available at the bottom of the page. Here you can access the release notes for the latest 

revision of e2 studio and the HTML-version of the SSP User Manual.

Downloading the SSP follows the same basic steps, but remember, you only need to do that if you previously chose 

to select the Standalone Installer. To initiate the download, go to the main page of the Synergy Solutions Gallery and 

scroll down to Software. Click on the Synergy Software Package entry. The SSP-page will show. Again, scroll down 

to Gallery Download and select Download Standalone Installer at the right-hand side of the current release. As you 

already downloaded the standalone installer for e2 studio, there is no need to go for the platform installer. Unless you 

changed your mind, of course. As with the previous download accept the license agreement and you are all set. At the 

bottom of the page, additional documentation for the SSP is available: The User’s Manual as PDF- or HTML-version, the 

Software Datasheet, release notes and X-Ware™ documents, as well as a link to the applications projects available.

If you just want to be up and running as soon as possible, there is no need to create a license at this stage. The SSP comes 

completely with an evaluation license, which has some restrictions on viewing protected source code, but provides the full 

functionality of the tools otherwise.
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Once the download of the Platform Installer is complete, you should have a file called setup_sspv1_7_0_e2s_v7_5_1.zip 

in your download-folder. The name may vary depending on the revisions of the tools. It is a fairly big file, with a size 

of more than 1.3 GB

To start the installation, the downloaded archive needs to be decompressed first. This will create a file named 

setup_sspv1_7_0_e2s_v7_5_1.exe. Double-click on it to start the setup. If you are running Windows 10, and depending 

on the security settings of your workstation, installation might stop with a warning from the operating system that 

“Windows protected your PC”. In this case, click on More info and on Run anyway, and the installation will proceed. 

Windows® 7 and 8 may produce a similar warning. Just click Yes to continue. You can also safely answer Yes to the 

question “Do you want to allow this app to make changes to your device?” in the User Account Control dialog box appearing. 

4.2.2      Installing the Tools Using the Platform Installer

Dismiss the first dialog box, asking if you want to Install, modify or remove the tools, by clicking on Yes. The installer will 

ask you for the install type (see Figure 4-1). There are two options: Quick Install, which simply installs e2 studio and the SSP 

with their default settings and runs without any user interaction, or Custom Install, which allows not only to install the 

ISDE and the Synergy Software Package, but also TraceX® and GUIX™ Studio as optional components. The quick installation 

is the way to go, if you want to get going as fast as possible. But, as we will use TraceX® in chapter 11, the custom 

installation is more useful for our purpose. No matter how you decide now, things can be changed any time later on by either 

re-running the Platform Installer or by calling the respective Standalone-Installer(s).

Figure 4-1: The custom installation is the way to go, as we want to install TraceX as well
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So, select Custom Install and click on Next. The installation routine will check that the install directory is ready and that all 

components are available. Dismiss the result-screen by clicking on Next. Once the Optional Component dialog shows, select 

TraceX® (compare Figure 4-2) and click again on Next. The screen showing will present you the various software agreements 

for the components to be installed. Check the box with I accept the terms of the Software Agreements” and click on Next 

on this screen and Install on the summary-screen following. The installation will start.

The next window appearing is the installation dialog for TraceX® (see Figure 4-3). For more information on the installation 

process, you might want to refer to chapter 11.3, but for now, the default values will do it. The Platform Installer will 

present you a last screen called Results. On this screen, just deselect Run e2 studio? and View Renesas SSP User Manual? 

and click on OK. This completes the installation and you are ready for a first test of the development environment.

Figure 4-3: The installer for TraceX will start in a separate window. Just accept the defaults
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If you decided to use the standalone installers, there should be two files in your download-folder by now: One is called 

setup_e2_studio_7_5_1_R20190813.zip (the revision number may vary) containing the installer for e2 studio and the other 

one is called SSP_Distribution_1.7.0.zip (again, the revision number may vary) containing the installer for the SSP.

The installation-sequence is important: The e2 studio ISDE needs to be installed first to allow correct integration of the 

SSP later on. To start the ISDE-installation, the downloaded archive needs to be decompressed first. This will create a 

file named setup_e2_studio_7_5_1_R20190813.exe. Double-click on it to start the setup. If you are running Windows 10, 

and depending on the security settings of your workstation, installation might stop with a warning from the operating 

system that “Windows protected your PC”. In this case, click on More info and on Run anyway, and it will proceed. Windows® 

7 and 8 may produce a similar warning, just click Yes and the installation will proceed.

Follow the dialogs of the installer. If your workstation is behind a proxy, you may want to configure it at the Welcome-

screen (lower right link) to ensure that the installation will work as expected. Click on Next and provide the installation 

path. Use the default or change it to suit your needs, but remember your selection. Later on you will need to install the

SSP into the same folder. On the next screen, the device families can be chosen. Make sure to select Renesas Synergy™.

4.2.3      Installing the Tools Using the Standalone Installers

Click on Next and you will be presented with a couple of choices for extra components to be installed (see Figure 4-5). 

Make your choice. While most options are not particularly useful for Renesas Synergy, you might want to install the support 

for SVN and GIT. If you do not know yet, don’t worry: You can re-run the installer any time later to add or remove features 

without having to go through the complete installation process again, or add the components directly from inside e2 studio.

Figure 4-4: Make sure to select the support for Synergy devices



Figure 4-5: Nothing here is essential at the beginning and can be added later

On the following components screen (see Figure 4-6), having everything selected is the way to go. Especially take care not to deselect 

any of the Debug components. If you do so, you will not be able to create a debug configuration and to connect to a target board.

The next screen will allow you to select additional software and the compiler (see Figure 4-7). Check the box beside 

GCC ARM® Embedded 7.2 2017q4 (or later revision) to install the code generation tools. Accept the terms of the Software 

Agreements on the next screen. Click on Install twice and the installation will start. Be patient, it will take some 

minutes. Allow the installation of the device drivers from Renesas once prompted.

Later in the process, the installation of the GCC toolchain will start automatically. Follow the directions of the installer and 

wait for the installation to complete. When asked for the installation path it is highly recommended to leave it at the default, 

or to write down the exact location. The automatic toolchain integration will only work if it was installed at the default 

location. If you altered the path, you have to manually integrate it later on.

Figure 4-6: You should leave everything selected on this screen
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Figure 4-7: It’s best to always select the latest compiler version

The next step is to install the SSP. For that, locate the downloaded zip file SSP Distribution_1.7.0.zip and extract and run 

SSP_Distribution_1.7.0.exe. Follow the directions of the installer until you reach the Choose Components screen. Make sure that the 

SSP_Release_Pack and the SSP_Documentation are selected. On the next screen check the path to confirm that you install the SSP 

in the root folder of the previously made e2 studio installation. The ISDE was installed to C:\Renesas\e2_studio by default. 

If you changed that during the setup of the e2 studio, you have to enter the correct path here. Click on Install and the 

installation will start. During the process, you will be asked where to install the documentation. Accept the default, which points 

to C:\Renesas\Synergy or enter your own path. This will install the following documents: The HTML-version of the SSP User’s 

Manual, a readme-file detailing last-minute updates and a PDF-file with SSP developer examples.

Once this installation has finished click on Close on the Success screen. You are all set and it is time to start the ISDE for the first time.

There will be a last screen, asking for some final steps. Check Add path to environment variable, as shown in Figure 4-8. This will 

add the path of the toolchain to the Windows environment and is necessary to insure an easy registration of the toolchain with 

e2 studio. At this point there is no need to run gccvar.bat, so you can uncheck this box. Click on Finish and later also close the 

installer of the e2 studio, once finished.

Figure 4-8: It is important to add the path to the environment variable 
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4.2.4      Starting for the First Time

Start e2 studio from the Start Menu of the PC. It will ask you for a location for the workspace. You can accept the default 

or choose your own. As this is the first time you start the ISDE, it will extract and refresh additional support files and will 

restart itself afterwards. During the startup process, you should see a window called Toolchain Integration, as long as you 

installed the GCC toolchain at the default location. Make sure to select the version 7.2.1.20170904 (or higher) of the GCC 

ARM® Embedded toolchain you installed before and click on Register. Failing to do so will prohibit compilation of your 

projects later on and you will have to manually register the tools from inside the ISDE.

Figure 4-9: Failing to select the installed tool chain here will result in build problems

Once you are at the Welcome screen dismiss it by clicking on the Workbench icon at the upper right-hand corner of the screen. Next 

step is to create a first simple project to ensure that everything is working. For that, go to File → New → Synergy C/C++ Project 

on the menu bar, which will bring up a new window called Templates for New Synergy C/C++ Project. Select Renesas Synergy C 

Executable Project and click on Next. This will start the project configurator. Enter a name for this project, for example 

“MySynergyProject” and select the GCC ARM® Embedded toolchain at the right hand side. The next step is to point the 

e2 studio to a valid license file, if it is not automatically listed. During the installation of the SSP an evaluation license was 

placed in the following folder <e2 studio installation path>\internal\projectgen\arm\Licenses. If you chose the Platform 

Installer, the <e2 studio installation path> will be C:\Renesas\Synergy\e2studio_v7.5.1_ssp_v1.7.0, and if you opted for the 

Standalone Installer, it will be C:\Renesas\e2_studio and the file selector will get you straight to this location. Select the 

(only) file there, with the name SSP_License_Example_EvalLicense_20180725.xml (or similar). Once loaded it will show 

the license information, the supported components and the related permissions in the window below.

The evaluation license you just installed allows you to use all parts of the Synergy Tools. The only limitation is that viewing 

the source code for ThreadX®, X-Ware™ components, libraries, stacks, and Application Frameworks API code will be 

limited. If you want to view this code, you will need a development and production license, which can be requested from the 

Synergy Solutions Gallery.

 

Click on Next to get to the device and tools selection screen. Select a board. As we only want to test the development 

environment, simply select the S5D9 PK for this first test and set the corresponding device to R7FS5D97E3A01CFC, if not 

already listed. Have a look at the toolchain. It should read GCC ARM Embedded with the version 7.2.1.20170904 or later. 
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If you installed the GNU-tools but they are not listed here, you need to integrate them manually. To do this, leave the 

New Project Wizard and go to the Help-menu of e2 studio and select the entry Add Renesas Toolchains. Please note that 

the Scan option only works for toolchains having been installed at their default location. If you haven’t installed the 

GNU-tools at their default location, either enter the path to your custom folder in the entry field or browse to the location 

using the files browser.

Next step is to select a project template. A project template includes the correct device and board dependent Board 

Support Library (BSP) and, if chosen, ThreadX® support enabled (no matter which template is chosen, ThreadX® can be 

enabled in the Threads tab of the Synergy Configurator). In addition, some of the templates include complete example 

projects as well. For our test, it is sufficient just to use a basic package, so select Blinky. Click on Finish. The configurator 

will extract all necessary files and will ask you if you want to open the Synergy Configuration perspective. Answer 

Open Perspective and the perspective for the Synergy Configuration will show. In the configurator, you could configure the 

SSP and most of the on-chip hardware of the processor. For the template we used for this example, everything has 

already been set, so click on the small green arrow saying Generate Project Content at the upper right-hand corner of 

the window and the configurator will create the configuration files and add them to the project.

 

Finally click on the small “Hammer”-symbol near the left hand corner of the toolbar on top of the ISDE and the project will 

compile and link. Once it has finished, it should show a status of 0 errors, 0 warnings after completion.

Now everything is set up and working and you are ready to start your own project. But hold on for a moment and ponder for

 a few seconds what we just did. I would think that for setting up this enormous software environment for a complete family 

of microcontrollers, the process is very easy and straightforward. Remember, we installed a software package with over 200 

man-years of development effort and a complete ISDE in less than 10 minutes. I consider this as a very effortless process!

And, if something went unexpectedly wrong during the installation, you know help is always available, even right out of 

e2 studio: Go to Help → Synergy Helpdesk and you will be directed to the Synergy Support page on the Internet. Another 

possibility is to click on the Support icon on the Summary tab of the Synergy Configuration perspective. This will open the 

Synergy Support page inside your web browser.

4.2.5      Keeping Your Installation Up-To-Date

Having installed the tools, you might want to keep them in good shape, which means you want to keep them up-to-date. 

Or you are so excited about all the possibilities the Eclipse-based ISDE offers, that you want to install additional software. 

Keeping the installation current is achieved by loading the latest installations from the Synergy Solutions Gallery. Using 

the Check for Updates feature inside e2 studio is not recommended, as the updates there may not add anything useful for 

the Synergy Platform.

 

If you want to install additional software, go to Help → Install New Software. On the following screen, choose the 

All Available Sites to search all sites and you will be presented a list of software available for download. And, of course, 

another way to get updates is to go to your favorite website, the Synergy Solutions Gallery, where you can find updates 

and additional software as well. For updates to the SSP, the Synergy Solutions Gallery is the best place.

 

Now that we know that the installation is working, the next steps will be to check out a development kit and to write 

your very own code.
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4.3      Downloading and Installing the IAR Embedded Workbench® for Renesas Synergy™

12

This part of the chapter deals with the IAR Embedded Workbench® for Renesas Synergy™ (IAR EW for Synergy), which is completely 

integrated with the Renesas Synergy™ Platform. To reach this level of integration, Renesas created the Synergy Standalone Configurator 

(SSC), an Eclipse-based RCP application, which is available to IAR EW for Synergy users as download from the Synergy Solutions Gallery. 

The SSC includes the Synergy Project Generator and is otherwise identical to the Synergy Configurator in e2 studio.

The key features of the IAR EW for Synergy are:

 

All these outstanding features are included with the purchase of just one Synergy MCU and customers using the Synergy Platform 

receive a head-start never seen in the industry before.

The next paragraphs will walk you through the different steps of downloading and installing IAR EW for Synergy, the SSC, and 

the Synergy Software Package (SSP) on your Windows® workstation. You have two choices: You can either use the Platform Installer, 

which combines the installers of IAR EW for Synergy, SSC and SSP in a single package, or use the Standalone Installers for each 

individual package. It is up to you and it does not really matter, how you decide. The results are identical.

4.3.1 Download of the Various Installers

The first step is to download the installation packages. On the Synergy Solutions Gallery, make sure that you are 

logged into My Renesas and scroll down to Software Tools and click on the entry for IAR Embedded Workbench® 

for Renesas Synergy™. The page for the tool will show. Scroll down to the Download section of the page and click 

either on Download Platform Installer or on Download Standalone Installer at the right-hand side of the current public 

release, which at the time of printing is 8.23.3. When the license agreement for one of the installers pops up, read 

and accept the agreement by clicking on the I Accept button and the download of the zipped installer will start. 

While either the Platform Installer or the installer for IAR EW for Synergy is downloading, take some time to review 

the documentation available at the bottom of the page. Here you can access the Getting Started Guide and the Release 

Notes for the latest revision of the ISDE.

You will need a separate license for IAR EW for Synergy from IAR Systems®. It can be acquired either by clicking the link 

 ¡ Integrated development environment with project management tools and editor.

 ¡ Highly optimizing C and C++ compiler and linker for Renesas Synergy™ devices.

 ¡ Integration support for Renesas Synergy Standalone Configurator (SSC).

 ¡ C-STAT and C-RUN code analysis tools included.

 ¡ Extensive HW target system support.

 ¡ Power debugging to visualize power consumption in correlation with source code.

 ¡ C-SPY® Debugger with JTAG/SWD support and support for RTOS-aware debugging on hardware.

 ¡ Support for ETM Trace.

 ¡ Comprehensive user and reference guides and context-sensitive help function.

 ¡ Compliant with ARM® Embedded Application Binary Interface (EABI) and ARM Cortex® Microcontroller.

 ¡ Software Interface Standard (CMSIS).

 ¡ First level support provided by Renesas through the standard Synergy support channels.
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provided for this purpose under Installation Instructions on this page, or, if you decided to use the Platform Installer, at 

the end of the installation process. Both ways will get you to a page on IAR Systems web site. All you need is to enter 

your email address and to click on Get license. An email with the license number and the instructions on how to activate 

it will be sent to your address. Retain this mail for further reference, as you will need it for additional installations.

If you didn’t decide to use the Platform Installer, the next step is to download the Synergy Standalone Configurator. 

Go back to the Solutions Gallery, scroll down to the Software Tools section and click on the entry named Renesas Synergy 

Standalone Configurator (SSC), which gets you to the details page for the SSC. Scroll down to the Download section 

and click on the Download button on the right-hand side of the Current Public Release. Accept the license agreement and 

the download of the zipped installer will start. While waiting for the download to complete, check the installation 

instructions and the release note for last minute updates.

Downloading the SSP follows the same basic steps, but remember, you only need to do that if you had previously chosen 

to use the Standalone Installer. To initiate the download, go to the main page of the Synergy Solutions Gallery and scroll 

down to Software. Click on the Synergy Software Package entry. The SSP-page will show. Again, scroll down to Gallery 

Downloads and select Download Standalone Installer at the right-hand side of the latest release. As you already downloaded 

the standalone installer for IAR EW for Synergy, there is no need to go for the platform installer. Unless you changed your 

mind, of course. As with the previous downloads accept the license agreement and you are all set. At the bottom of the 

page, additional documentation for the SSP is available: The User’s Manual as PDF- or HTML-version, the Software datasheet, 

release notes and X-Ware™ documents, as well as a link to the applications projects available.

If you just want to be up and running as soon as possible, there is no need to create a license at this stage. The SSP comes 

complete with an evaluation license, which has some restrictions on viewing protected source code, but provides the full 

functionality otherwise.

4.3.2 Installing the Toolchain Using the Platform Installer

Once the download of the Platform Installer is complete, you will have a file called setup_sspv1_7_0_iarew_8_23_3.zip with 

a size of approximately 1 GB in your download-folder. The revision numbers may vary depending on the versions of the tools.

To start the installation, the downloaded zip archive needs to be decompressed first. This will create a file named setup_

sspv1_7_0_iarew_8_23_3.exe. Double-click on it to start the setup program. If you are running Windows 10, depending on 

the security settings of your workstation, installation might stop with a warning from the operating system that “Windows 

protected your PC”. In this case, click on “More info” and on “Run anyway”, and the installation will proceed. Windows 7 

and 8 may produce a similar warning. Just click Yes to continue. You can also safely answer Yes to the question “Do you 

want to allow this app to make changes to your device?” in the User Account Control dialog box appearing.

Dismiss the first dialog box of the installer, asking if you want to “Install, modify or remove” the tools by clicking on Yes. The installer 

will ask you for the install type (similar to Figure 4-1). There are two options: Quick Install, which simply installs the SSC and the SSP 

with their default settings and calls the installer for IAR EW for Synergy at the end, or Custom Install, which allows not only to 

install the ISDE, the Synergy Standalone Configurator and the Synergy Software Package, but also TraceX® and GUIX™ Studio 

as optional components. The quick installation is the way to go, if you want to get going as fast as possible. But, as we will use 

TraceX® in chapter 11, the custom installation is more useful for our purpose. No matter how you decide now, things can 

be changed at any time later on by either re-running the Platform Installer or by calling the respective Standalone Installer(s).
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For our purpose, select Custom Install and click on Next. The installation routine will check that the install directory is 

ready and that all components are available. Dismiss the result-screen by clicking on Next. Once the Optional Component 

dialog shows, select TraceX® (compare Figure 4-10) and click again on Next. The screen showing now will present you 

the various software agreements for the components to be installed. Check the box with “I accept the terms of the 

Software Agreements” and click on Next on this screen and Install on the summary-screen following. The installation 

will start.

The next window appearing is the installation dialog for TraceX® (see Figure 4-3). For more information on the installation 

process, you might want to refer to chapter 11.3, but for now, the default values will do it. Once the installation of TraceX® 

is complete, the installer for the IAR Embedded Workbench for Renesas Synergy will show. Follow the instructions, read 

and accept the license agreement and change or accept the destination folder for the installation. When asked which 

USB drivers should be installed, please keep the J-Link driver selected, as it will be needed for the next exercises, which 

will use the S5D9 Promotion Kit. But feel free to deselect the I-jet driver, if you do not plan to use an IAR Systems® debug 

probe (see Figure 4-13). Continue to follow the instructions of the IAR-installer until the installation starts. The process 

itself will take a while and when finished, unselect View the release notes and Launch IAR Embedded Workbench at the 

last screen.

The platform installer will present you a last dialog called Results. On this screen you can select to visit the Renesas 

Synergy Solutions Gallery after exiting the installer or to acquire a license for the IAR Embedded Workbench for Renesas 

Synergy if you haven’t already done that. When this entry is checked, it will call the registration page on the website of 

IAR Systems®. There you will only have to enter your email address and the license number will be mailed to you. Exit the 

installer by clicking on OK. This will complete the installation and you are ready for a first test of the development 

environment.

Figure 4-10: Add TraceX to the selection as well
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4.3.3 Installing the Toolchain Using the Standalone Installers

Once all downloads are completed, the installation process can start. There should be three files in the download folder

by now: One is called EWSYN-CD-8233-18530.zip (the revision number may vary) containing the installer for the IAR EW 

for Synergy, one called SSP_Distribution_1.7.0.zip containing the installer for the Synergy Software Package and one 

called SSC_7.5.1.V20190813.zip (again, the revision numbers might vary) containing the installer for the Synergy 

Standalone Configurator.

Please note that the installation-sequence is very important here, so please follow the instructions below closely. 

The first tool to be installed is the Renesas Synergy™ Standalone Configurator. For that, locate the downloaded zip file 

SSC_7.5.1.V20190813.zip and extract and run SSC_7.5.1.V20190813.exe. Follow the directions of the installer until you 

reach the Choose Install Location screen. Either accept the default path or choose your own. If you decide not to use 

the default location, make sure that you write down the full path. You will need it later on. Click on Install and the 

installation will complete.

Figure 4-11: You can install the SSC either in the default location, or at any place you choose

Next, you will need to install the Synergy Software Package. Please note that you need to perform this step, even if you 

had previously installed the SSP together with e2 studio. The SSC needs its own installation. To start the process, locate 

the downloaded zip file SSP_Distribution_1.7.0.zip and extract and run SSP_Distribution_1.7.0.exe.

Follow the directions of the installer until you reach the Choose Components screen. Make sure that the SSP Release 

Pack and the SSP Documentation are selected. On the next screen you will be prompted to specify an installation directory for 

the SSP. Just point the installer to the directory where you just installed the SSC. If you accepted the default location, this 

will be C:\Renesas\Synergy\SSC_v7_5_1_V20190813 (or later), otherwise you will have to enter the correct path here.
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Figure 4-12: Make sure to specify the root folder of your SSC installation

Click on Install and the installation will start. During the process, you will be asked where to install the documentation. 

Accept the default, which points to C:\Renesas\Synergy or enter your own path. This will install a read-me file detailing 

last-minute updates and where to get the SSP User Manual on the web.

The final step is to install the IAR Embedded Workbench® for Renesas Synergy™. Locate the downloaded zip file 

EWSYN-CD-8233-18530.zip. Decompress the file and run the executable named EWSYN-CD-8233-18530.exe. On the 

selection screen appearing, click on Install IAR Embedded Workbench® for Renesas Synergy, which will start the 

installation process.

Follow the instructions of the setup-routine and read and accept the license agreement. Change or accept the destination 

folder for the installation. When asked which USB drivers should be installed, please keep the J-Link driver selected, as it will 

be needed for the next exercises, which will use the S5D9 Promotion Kit. But you can deselect the I-jet drivers, if you do not 

plan to use an IAR Systems® debug probe (see Figure 4-13).

Figure 4-13: Make sure that the J-Link driver is selected for installation, as it is needed 
later on
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Continue to follow the instructions of the installer until the installation starts. The process itself will take a while and when 

finished, deselect View the release notes and Launch IAR Embedded Workbench at the last screen. Click on Finish and the 

installation of the device drivers will start. Once this installation has finished as well, close the main installer by clicking on Exit.

With that, the installation of the IAR Embedded Workbench® for Renesas Synergy and the related tools is complete and 

it is time now to start the development environment for the first time.

4.3.4 Starting for the First Time

Start the IAR EW for Synergy from the Start Menu of your Windows® workstation. It will first prompt you for the 

language to be used for the workbench. Make your choice and click OK. Then the license wizard will start. Enter the license 

number you received by email when registering at the download page in the Synergy Gallery. Click on Next.

The license wizard will activate your license and a final screen will tell you that “A temporary license has been activated”. 

Don’t worry! Your license will be extended well in time before it will expire. It is valid for an unlimited period of time and 

has no per-customer limit. When prompted to extract the IAR Library Source for ARM, select Yes and the library extractor 

will start. Once it has finished, the setup process is complete.

Figure 4-14: Enter the registration number you received by email

Your next step is to create a first simple project to ensure that everything is working. There are several ways to get this done, 

but the simplest one is to go to Renesas Synergy→ New Synergy Project.

Figure 4-15: Select Renesas Synergy 
Project to create a new project
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The dialog appearing will ask you for a suitable destination directory for your workspace. A workspace is the container holding 

your projects and you can name it as you like, for example MySynergyWorkspace. Select a location that suits your needs best. 

Click on Save.

Once the workspace is created, the window showing will ask you to specify the location of your installed Synergy Standalone 

Configurator, which by default was either C:\Renesas\Synergy\SSC_v7_5_1_ssp_v1.7.0, if you used the Platform Installer, 

or C:\Renesas\Synergy\SSC_v7_5_1_v20190813, if you decided to go for the Standalone Installer, and the location and 

the name for the Synergy license file. You can find the later one in the \internal\projectgen\Licenses subdirectory of one of 

the installation directories given above (see Figure 4-16). The last item in the dialog asks you whether or not you want to like 

to replace any encrypted source files with decrypted ones. As this option is only applicable, if your license is a Renesas 

Synergy development and production license, you can leave this item unchecked, Click on OK.

Figure 4-16: Enter the correct locations for the SSC and the license file

Another Save As dialog will appear. Enter a name for this project, for example MySynergyProject. Click on Save. The IAR EW 

for Synergy will now start the Synergy Standalone Configurator. On the first screen of the SSC, select the board support you 

require. As we only want to test drive the development environment, simply select the S5D9 PK for this first test and check if 

the corresponding device was set to R7FS5D97E3A01CFC. Select it from the list, if not. Clic k on Next.

Now it is time to select a project template. A project template includes the correct device and board dependent Board Support 

Package (BSP) and, if chosen, ThreadX® support enabled (no matter which template is chosen, ThreadX® can be enabled later 

on in the Threads tab of the Synergy Standalone Configurator). In addition, some of the templates include complete 

example projects as well. For our test, it is sufficient just to use a basic package, so select Blinky. Click on Finish. The SSC 

will extract all necessary files and will start the Synergy Configurator. In this configurator, you can configure the SSP and most 

of the on-chip hardware of the processor. For the template we selected for this example, everything has already been set, so 

click on the small green arrow saying Generate Project Content (see Figure 4-17) at the upper right-hand corner of the 

window and the configurator will create the configuration files and add them to the project.
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Figure 4-17: The Standalone Synergy Configurator lets you configure most aspects of your application

Close the SSC by clicking on the ‘X’ icon at the top right corner of the window. When looking at the Workspace viewer of 

the Embedded Workbench, you will notice that the configurator added the required files to your project. Note that you can 

go back to the SSC anytime by clicking on the Synergy configuration icon on the main toolbar, by selecting Renesas 

Synergy → Configurator in the main menu, or by right-clicking on the Synergy entry in the project tree and selecting Open 

Renesas Synergy Configurator.

Figure 4-18: The SSC can be called any time later again

Finally click on the Make symbol in the toolbar or select Project → Make and the project will compile and link. Once it has 

finished, it should show a status of 0 errors, 0 warnings.
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And, if something went unexpectedly wrong during the installation, you know that help is always available on the Synergy 

Support page on the web. This page can also be accessed directly by clicking on the Support icon on the Summary tab 

inside the SSC. This will open the Synergy Support page inside your web browser. Remember that Renesas is the 

first point of contact for everything belonging to the Synergy Platform, and this includes the IAR Embedded Workbench® 

for Renesas Synergy™ as well!

4.3.5   Keeping Your Installation Up-To-Date

Having installed the tools, you might want to keep them in good shape, which means you want to keep them up-to-date. 

The best way to get updates for the IAR EW for Synergy, the Synergy Software Package and the Synergy Standalone 

Configurator is to go to your favorite website, the Synergy Solutions Gallery, where you can find all the updates needed.

4.5      Summary

Now that we know that the installation is working, the next steps will be to check out a development kit and to write your very own code. 

But hold on for a moment and ponder for a few seconds what we just did. I would think that for setting up this enormous software 

environment for a complete family of microcontrollers, the process is very easy and straightforward. Remember, we installed a software 

package with over 200 man-years of development effort and a complete development environment, be it e2 studio or the IAR EW for 

Synergy in less than 10 minutes. I consider this as a very effortless process!

Points to take away from this chapter:       .

 ¡ Installation is straightforward, but care should be taken to install in the right order.

 ¡ If you do not install the GCC tools to their default directory, you will have to register them manually inside the ISDE.

 ¡ IAR Embedded Workbench® for Renesas Synergy™ integrates the Synergy Standalone Configurator, bringing the complete 

functionality of the Renesas Synergy™ Platform to this development environment as well.

4.4      Installing the IAR Compiler into e2 studio

You have also the possibility to use the compiler of IAR Systems® inside e2 studio, making this world-class compiler available for your 

development inside this ISDE. For that you need to have both tools, e2 studio and IAR EW for Synergy, installed. Inside e2 studio, go to 

Help → IAR Embedded Workbench plugin manager. A list of available plugins will show. Select Synergy 8.x at the left pane, and 

check the box of the entry for 8.23.3 on the right side. The plugin manager will load additional components, which will take quite 

some time. A tiny progress bar at the bottom of the console area of e2studio shows the progress. This can be expanded if desired 

for more detail. Wait till it completes. Once the next dialog shows, select all plugins and click on Next twice. Accept the license agreements 

and finally click on Finish. The installation will start. If a Security Warnings dialog shows, dismiss it by clicking on Install Anyway 

and allow the installation to complete. Restart e2 studio when prompted. The next time you create a new project, the IAR compilers 

will show in the new project wizard and can be selected for your development.

More details on the installation process and how to migrate existing projects using the GCC toolchain can be found in an application 

note titled Installing IAR Compiler into e2 studio available from the e2 studio page on the Synergy Solutions Gallery.



Copyright: © 2020 Renesas Electronics Corporation

 
Disclaimer:

This volume is provided  for informational purposes without any warranty for correctness and completeness. The contents are not intended to be 

referred to as a design reference guide and no liability shall be accepted for any consequences arising from the use of this book. 


	BASICS OF THE RENESAS SYNERGY™ PLATFORM (Richard Oed)
	4 GETTING THE RENESAS SYNERGY™ PLATFORM TOOLCHAIN UP AND RUNNING
	4 GETTING THE RENESAS SYNERGY™ PLATFORM TOOLCHAIN UP AND RUNNING
	4.1 Introduction to the Synergy Solutions Gallery
	4.2 Downloading and Installing e2 studio and the Synergy Software Package 
	4.2.1 Download of e2 studio and the SSP
	4.2.2 Installing the Tools Using the Platform Installer
	4.2.3 Installing the Tools Using the Standalone Installers
	4.2.4 Starting for the First Time
	4.2.5 Keeping Your Installation Up-To-Date

	4.3 Downloading and Installing the IAR Embedded Workbench® for Renesas Synergy™
	4.3.1 Download of the Various Installers
	4.3.2 Installing the Toolchain Using the Platform Installer
	4.3.3 Installing the Toolchain Using the Standalone Installers
	4.3.4 Starting for the First Time
	4.3.5 Keeping Your Installation Up-To-Date

	4.4 Installing the IAR Compiler into e2 studio
	4.5 Summary


	Disclaimer



